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1. Problem Formulation 

The Gulf Coast region of Texas is a highly populated area where petroleum collection 

and processing, fishing, and tourism all play a vital role to the success of the Texas 

economy. Due to its location along the coast (and thus its low elevation), most of the 

people living and working in this region are regularly at risk of flooding from seasonal 

hurricanes in the summer. While these storms present an immediate problem, there is a 

more long-term issue that threatens the Gulf Coast: sea level rise as a result of climate 

change.  
Sea level rises from the combined effects of the thermal expansion of ocean water and 

the melting of land-based ice (i.e., glaciers and polar ice sheets) due to increasing global 

temperature. While this isn’t the first time in Earth’s history that sea level has risen from 

increased temperatures, the part that is concerning is the rate at which it is rising (Church 

and White, 2011). In a worst-case scenario, sea level is projected to rise by at least two 

meters (and possibly more) by 2100, (Rignot et al., 2011; Hansen et al., 2016) displacing a 

significant portion of the world’s population (~10% of the global population lives in regions 

with elevations less than 10 meters (Fitzgerald et al., 2008)). Two meters in 80 years may 

not seem like much, but consider the fact that sea level has risen 120 meters to it’s current 

position since the end of the last glacial maximum ~21,000 years ago (Lambeck et al., 2014). 

This is an average of 350 years for a 2 meter rise, compared to today’s projection of 80 

years for an equivalent rise; in other words, sea level is rising about four times faster than it 

has since the last glacial maximum.  
This realization is what motivates my study to understand how rising sea level will affect 

my home and possibly displace my family in the near future. My aim is to map new 

possible coastlines according to sea level rises of 1-3 meters, 5 meters, and 10 meters, and 

estimate a corresponding population displacement for each rise, respectively. By 

assuming a constant rate of sea level rise (1 meter every 40 years), each map will allow us 

to predict when we can expect certain areas to become inundated, and the rate at which 

populations become displaced. The results can be quantified as a measure of people 

displaced per “stage” of sea level rise. This information can be used to help communities 

understand their future hazards and mediate the associated risks of sea level rise, as well as 

prepare for life in a dramatically different environment from the one that exists today.  
 

2. Data Collection 

The first step is to acquire all the data necessary to perform this analysis. This includes 

DEMs from LiDAR raster data for the area of interest (from the USGS National Map), a shapefile 

containing points of Texas cities and population data from the 2010 Census (from the Texas 

Department of Transportation), a county outlines shapefile (from the USGS National Boundary 

Dataset), and a river shapefile and state of Texas hillshade (both from the Texas Water 

Development Board) to provide environmental context and use as a base map, respectively. 



Figure 1 provides an example of what data collection from one of these download portals is 

like.  

 

Figure 1. The USGS National Map Download portal. The map window shows footprints of the 1/3 arc-

second DEMs that comprise the area of interest. Selecting the “Info/Metadata” link next to each 

footprint opens a new tab containing metadata for each file (along with a download link for the 

metadata file). Selecting the “Download” link downloads a zipped file which I later extracted into a 

folder made for all my DEM files within a larger project data folder. File organization and a consistent 

naming method for files is crucial to quickly and easily finding and processing the data in ArcMap.   

3. Data Preprocessing 

Once all the files were downloaded and organized in their respective folders (I assigned a 

new folder for each “theme”), I loaded all the data into ArcMap. The first thing to do once all 

the data is imported into ArcMap (and arguably the most important) is to make sure the datums 

agree. Fortunately, only the cities shapefile datum did not conform with the rest; it was in WGS84 

instead of NAD83. I used the “Project” tool (Data Management > Projections and Transformations > 

Project, Fig. 2) and added the now properly projected cities feature into the Table of Contents, and 

removed the old copy.  



Figure 2. Using Project to convert the cities shapefile into the proper datum. Without this step, the 

cities would not be in the correct location with respect to the rest of the features on the map (including 

the coastline). This would affect the sea level rise interval at which certain coastal cities would become 

submerged.  

Another problem with the data is that the DEMs are not represented on a uniform scale; each 

raster has a different high and low value, which would affect the symbology of the elevation 

and my calculation of sea level across the area of interest. I used the “Mosaic to New Raster” 

tool (Data Management > Raster > Raster Dataset > Mosaic to New Raster) to stitch all the 

DEMs together into one large dataset with a uniform high and low. The shapefile download 

from the Department of Transportation of counties includes an outline for the state of Texas 

which I simply loaded into the map window.  I then used the Select by Location function to 

select the counties of interest which fall entirely within the mosaic (Brazoria, Calhoun, 

Chambers, Fort Bend, Galveston, Harris, Jackson, Liberty, Matagorda, Montgomery, and 

Wharton counties) and got an outline of these counties. This important new feature will be the 

cookie cutter we use to clip the rest of our data. Figure 3 shows the final result of this 

preprocessing.  



 

Figure 3. The final result of all data preprocessing. Note that the DEM raster conforms to one gradient 

with a uniform high and low (get comfortable during this step; such a large dataset takes several 

minutes to process). “sel_counties” is the feature I used to clip the cities, rivers, and base DEM; I made 

this feature by using the Select by Location function under the “Selection” tab to choose the counties 

near the coast that were entirely contained within the DEM. Once I reached this step, I was ready to 

begin putting together rasters to represent different sea level rises. 

4. ArcGIS Processing 

Now that all of the data is contained within the area of interest, we can begin representing 

elevation. This dataset still does not include a coastline, which is what we are trying to map. 

The all-important “Raster Calculator” tool (Spatial Analyst > Map Algebra > Raster Calculator) is 

very useful here; note that you must have the Spatial Analyst extension enabled to use this 

tool. Figure 4a shows the expression in the tool to return the intended output raster that 

represents a very detailed present coastline. I then used the “Raster to Polygon” tool 

(Conversion Tools > From Raster > Raster to Polygon) to convert this output raster into a vector 

polygon feature. Be sure to choose “Value” under the “Field” field, and check the simplify 

polygons box to simplify the polygons into smoother shapes. Figure 4b shows the result of this 

vectorization.  
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Figure 4. a) Raster Calculator showing the expression which returns a raster showing the cells which are 

greater than 0 (i.e., cells which correspond to land) and less than 0 (i.e., cells which correspond to 

water), and b) the result of using Raster to Polygon to vectorize the output raster from 4a. This 

represents the current coastline of the area of interest along the Gulf Coast. Note the number of cities 

that lie right on the coastline; these are highly at risk of sea level rise.  



The procedure to obtain new coastlines for each stage of sea level rise (remember, we 

want a coastline corresponding to a rise of 1 meter, 2 meters, 3 meters, 5 meters, and 10 

meters) is very similar to the way we got the current coastline. The only difference is the 

expression plugged into Raster Calculator. If “base_dem > 0” returns a representation of the 

cells which are above and below an elevation of 0 (i.e., sea level), then “base_dem > 1” should 

return the cells which are above and below and elevation of 1. Sea level rising by 1 meter 

moves the “0 elevation” boundary up by one meter; by using the Con function in Map Algebra 

we can find an outline of where this condition holds true, and this is how we will model sea 

level rise for each interval. This method has its limitations, a discussion of which follows at the 

end of the report. For the scope of this project, however, this should be an appropriate 

approximation of how we can expect the coastline to change over time as sea level rises at its 

current, constant rate.  

I performed this set of steps (using Raster Calculator, then vectorizing the output raster) 

five more times to get the coastline that results from shifting sea level up by 1-3 meters, 5 

meters, and 10 meters by using the appropriate rise interval in the Raster Calculator expression. 

The final maps that represent these sea level rises are included in Figures 8-12; for the 

simplicity’s sake in the remainder of the report, we will look at a rise of 5 meters as our 

exemplar, but note that the analysis that follows was repeated for each interval of sea level 

rise. Figure 5 shows the result of raster calculation and vectorization for a 5 meter sea level rise. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 5. The expression “Con(“base_dem”, 1, 0, “VALUE > 5.0”) returns a raster that gives a 

value of 1 in cells where the “VALUE” field of “base_dem” is greater than 5, and a value of 0 in cells 

where it is less 5. Vectorization gives a smoother image of a coastline risen by 5 meters.  



 It is clear to see that multiple cities lie on elevations of less than 5 meters, and are now 

submerged underwater. Our goal is to find out the total population of people living in all of 

these submerged cities; this gives us the number of people that would be displaced for a sea 

level rise of 5 meters. Using the expression “SELECT FROM 5m_cl_vec WHERE: “gridcode” = 0” 

in the Select by Attribute function selects all water polygons within the vectorized 5 meter sea 

level rise shapefile. Then I exported this selection into a new shapefile and added it to the map. 

Now I can run Select by Location to find all cities that are contained within these water 

polygons. My next step would be to right click the field “POP2010” in the selected records of 

the cities attribute table, but this cannot be done because (for some reason) POP2010 is 

classified as a string value rather than a numeric value. A quick workaround is to simply add a 

new field and use “Field Calculator” to populate it with values from POP2010, making sure to 

classify the new field as numeric. Finally, I can right click the new field’s header and choose 

“Statistics” to find the total population of all cities with population data that fall within the 

water polygons: 242,091 people. This value (along with the values for population that falls 

within the water polygons for a 1 meter, 2 meter, 3 meter, and 10 meter rise) will go into a 

table that records the increasing number of displaced people as sea level rises. Figure 6 shows 

the summary statistics of the cities inside the 5 meter water polygons.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 6.  The summary statistic window for the cities that fall within the 5 meter sea level rise. The sum 

value of 242,091 is the total number of people living in these selected cities, and this value will be 

analyzed against rising sea level along with the other population values for the rest of the intervals. The 

field “pop_stats” is the new field I added and populated with the values from “POP2010”.  

 



5. Data Presentation 

Table 1 reflects the results of following through with the process of vectorizing the output 

raster of our calculation and selecting the cities that are contained within the water polygons 

for each sea level rise interval. The same data is graphed in Figure 7.  

 

 1 m Rise 2 m Rise 3 m Rise 5 m Rise 10 m Rise 

# People 
Displaced 

0 20,798 128,428 242,091 242,091 

# Cities 
Inundated 

0 18 26 50 92 

% of Total 
Cities 

0 6.6 9.6 18.4 33.8 

 
Table 1. Populations displaced, number of cities submerged underwater, and percentage of total cities 

(n = 272) within the area of interest that become submerged. Some more limitations of the dataset are 

revealed here; number of people displaced doesn’t increase from a 5 meter rise to a 10 meter rise even 

though the number of inundated cities almost doubles. This is because many of the smaller cities within 

the area of study did not come with census data in the attribute table.  
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Figure 7. a) Number of people displaced per interval sea level rise. This data is not entirely accurate due 

to a lack of population data for every city in the dataset. b) Number of cities inundated per interval sea 

level rise. Plotting sea level rise this way provides a more inclusive view of the number of communities 

that will be affected, but takes away the ability to understand the number of people displaced with 

every sea level rise.  

 

 Figures 8-12 are a collection of maps which detail the progressive sea level rise along 

the Texas Gulf Coast in the context of amount of land inundated and as a changing coastline. An 

in-depth discussion of these maps is presented in the following section. In order to put these 

maps together, I had to project all the data into a projected coordinate system (as all of our 

analysis so far has been perform on data that has only been assigned a datum, not a XY 

coordinate system). I chose the Texas Centric Mapping System (Albers) because it uses the 

NAD83 datum that all of my data are already in and there is little areal distortion. I mapped the 

area of inundated land by using Raster Calculator to subtract the current sea level DEM (Fig. 4b) 

from each of the sea level rise DEMs (Fig. 5) to get the difference between the two (i.e., the 

area where water overlaps between the two rasters). From here, putting together the maps is 

simply a matter of choosing a visually effective and pleasing color and symbology scheme that 

is readable on a letter-size page. I have chosen to make each of my maps full-size to maximize 

readability and clarity.  

 I chose not to represent the changing coastline for a sea level rise of 1 meter because no 

cities become submerged for a sea level rise of this magnitude, thus there is no displaced 

population. 

 

 

 



 

 

 

 

 

 

Figure 8. Map showing the location of the area of study along the Texas Gulf Coast. Cities important to 

Texas economy are symbolized in yellow. Total number of cities is 272. 



Figure 9. Maps showing the area of land that becomes submerged by a 2 meter sea level rise, and the 

resulting new coast line that can be expected by 2100 if sea levels continues at today’s constant rate.  



Figure 10. Maps showing the area of land that becomes submerged by a 3 meter sea level rise, and the 

resulting new coast line that can be expected by 2140 if sea levels continues at today’s constant rate. 



Figure 11. Maps showing the area of land that becomes submerged by a 5 meter sea level rise, and the 

resulting new coast line that can be expected by 2220 if sea levels continues at today’s constant rate. 



Figure 12. Maps showing the area of land that becomes submerged by a 10 meter sea level rise, and the 

resulting new coast line that can be expected by 2420 if sea levels continues at today’s constant rate. 



6. Discussion 

To recap, my original goal was to map new possible coastlines for sea level rises of particular 

magnitudes (1-3 meters, 5 meters, and 10 meters) along the Texas Gulf Coast at specific points 

in the future, given that the current rate of sea level rise remains at the constant rate of today’s 

1 meter rise every ~40 years. I also set out to understand these environmental changes in the 

context of population dynamics to get an estimate of population displacement caused by these 

changes in terms of people displaced per interval sea level rise.  

As mentioned previously, I chose not to include a map showing the sea level rise for one 

meter because, as it turns out, a rise of this magnitude does not result in any displacement. 

Even a lack of data here can be useful though; we can estimate that there is a minimum of one 

meter of vertical space separating the coast from people living at the lowest coastal elevations; 

if it takes 40 years for sea to rise by this much, then we have at least until 2060 until 

communities are seriously at risk of flooding and displacement.  

In 2100 we predict a sea level rise of two meters. At this point, 6.6% of the total number of 

cities becomes inundated, displacing ~20,000 people. Herein lies the first crucial limitation of 

the study. Choosing to map sea level rises by the meter returns a fairly coarse temporal 

resolution for understanding how people will begin to be affected by rising sea level, and a 

more thorough understanding of the nature of this sea level rise requires its mapping on a finer 

(centimeter) scale. The data for this type of analysis exists; in fact, the resolution of my DEMs 

are likely capable of this type of fine-tuned analysis, but in the interest of simplicity and time 

management I chose to stick with a coarser temporal resolution.  

From a rise of three meters all the way to ten meters, the coast begins to change 

dramatically; most of Galveston goes underwater first, and the bay area southeast of Houston 

moves further inland. Matagorda, Port O’Connor, Port Lavaca and Kemah now lie under shallow 

ocean water as well, and the characteristic protected bays and lagoons disappear as the barrier 

islands get washed away. By 2420 (corresponding to a ten meter sea level rise), new features 

begin to form; a long bay reaches inland on the far northeast side of the study area, and many 

cities present just 400 years earlier are now submerged and (hopefully) abandoned.  

An important complication is the fact that in the real world, the rate of sea level rise would 

almost certainly not remain constant. However, modeling the factors that control the rate of 

sea level change and including them in this analysis are beyond the scope of this assignment, so 

I decided to approximate it as remaining constant at a fixed rate through time. In addition to 

simplifying real world processes, it must be noted that the forces that shape the Texas Gulf 

Coast will likely continue to do so in the future, thus affecting the nature of the landscape that 

forms; that is, the new coastline will not be solely dependent upon the amount that sea level 

rises.  

As for issues with the data itself, two major sources of concern surround the significant lack 

of population data. Not only are these population counts almost ten years old, they are also 

absent for consequential amount of the cities I included in the analysis. As a result, the number 

of people displaced as a result of sea level rise in these models are without a doubt severe 



underestimates. The other problem lies in the intervals with which I chose to model sea level 

rise. The significant jump in the number of people displaced between 2 and 3 meter sea level 

rises is almost 100,000. Clearly, some big changes are happening in places where people reside, 

and as described before, the temporal resolution that these rise intervals suggest is not fine 

enough to disentangle the nuances of population displacement in these circumstances.  

Despite the numerous inconsistencies, complications, and limitations of this particular case 

study, it is still clear to see that the people living along the Gulf Coast of Texas will be facing a 

significant hazard in the near future, and studies like these can help us understand how to 

prepare for and handle the environmental risks associated with climate change not just on the 

Gulf Coast, but in any densely populated coastal communities.  
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